
Chapter 7

Web Art

The Internet Layer

Creating an Image Map

Splitting Images

Web Effects

HTML Editor Overview

The Editor’s Screen

Creating an HTML Document

Use these options to create images for Internet web

pages. ImageForge also includes an editor optimized

for HTML code for producing the web documents

themselves.

The Internet Layer

This tab gives you controls for splitting images

across web document tables, creating clickable

image maps, and access to the document editor for

fine-tuning the code.

The Tool Options are different for this layer. And the

tools on the Tool Bar are also changed to those used
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for splitting and linking areas of the

image. The Tool Bar only displays those

tools which may be used on this layer.

T h e Line tool is used for spl i t t ing

images into smaller pieces (for use in

HTML tables), and the Brush, Rectangle

a n d Circle a r e u s e d f o r d e f i n i n g

clickable hot spot areas for the image.

Create an Image Map

An image map is a picture which contains “hot spots”

which may be clicked when the image is viewed in a

b r o w s e r ( e . g . , N e t s c a p e , O p e r a o r I n te r ne t

Explorer).

1 Open the image you wish to use.

1 Go to the Internet tab and select the Rectangle tool.

1 Drag the tool to surround the area which you want to

be active (assign a color to each area you create if

desired). Note that all areas will be transparent when

viewed in a browser.

1 Use the Arrow selector to select the new hot spot.

1 In the URL field, type the URL address of the document

to be loaded (or other action, such as mailto:) when

the user clicks this area.

1 If you make a mistake, click the Delete (minus) icon.

1 Click on the Generate Code icon to write the HTML

code for insertion into your web document. A copy of

the image pieces will also be saved with the same name

as the HTML document generated.

1 Open the new document in your web editor and cut

and paste the code into your HTML document.

Split Horizonally
Delete

Document to Link
to when Clicked

Generate
Code

HTML Editor
Vertical Split
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Split an Image

You may split an image to control how an image is

loaded in a web browser. The smaller pieces often

load faster than a single large image. This function

may be used to generate split images for other

purposes (puzzles, programming, tiles, etc.).

1 Open the image you wish to split into pieces.

1 Go to the Internet tab and select the Line tool.

1 Choose whether to split Horizontally or Vertically

from the Tool Options.

1 Click on the image to split.

1 If you make a mistake, click the Delete (minus) icon.

1 Use the Arrow selector to select a division or move a

split line.

1 You may create image map hot spots if you desire.

1 Click on the Generate Code icon to write the HTML

table codes for insertion into your web document. The

image pieces will also be generated.

1 Assign a file name for the HTML and image pieces.

Selected Region
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Web Effects

The Effects menu contains a Web Effects section

which automatically generate image-related code for

use in HTML web page documents. The steps for

using these options are:

1 Click on the Effects menu, then select Web Effects.

1 Select  the Effect from the  column  on  the  left  side.

Then provide the image name and other information

needed.

1 Once you have defined the requested information,

you can generate the code by clicking on the yellow

Apply button.

1 To edit the code, click on the Editor button.

1 Depending on the final location of your images and

web page, you may need to adjust the HTML code to

reflect the URL for the images.

1 You may cut and paste the code into a pre-existing

document. Pay particular attention to the location(s)

of items within the <head></head> and <body>

</body> containers. Place the code in the same

positions when importing into your existing HTML.

Because more functions are often added to the list,

you should consult the program’s Help Topics for

descriptions for individual Effects. See the Web

Effects section in the Menu Commands topic, or

simply go to the Web Effects menu selection and click

the Help button.

HTML Editor Overview

ImageForge PRO includes an editor specialized for

the creation of web pages and other specialized

documents intended to be viewed electronically.

Th i s ed i tor suppor ts inser t ion of hyper l inks

(highlighted text which, when clicked, jumps to

documents elsewhere on a system or network).
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While you may also use this editor to create other

types of documents, some document features (such

as character formatting) can only be displayed or

printed from browser-type software.

The Editor’s Screen

The Editor window contains the following parts:

Menu

Use the menu to open and save documents, to

change the editors settings, etc. To see descriptions

of all of the menu functions, click on the Help menu

heading and then click Help Topic.

Other Documents List

This list keeps track of other documents which you

have opened during the current editing session.

C l i c k on the a r r o w bu t ton to d i s p l a y o the r

Documents
List

Tool BarsMenu

Formatting
CodeStatus Bar

Document
Editing Area
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documents which have been opened. Simply click on

a document’s title to quickly reload it into the editor.

Formatting Code Selector

This list comes preconfigured with a wide variety of

HTML document formatting codes. Simply click on

the desired code from the drop-down list, and the

codes will be inserted at the cursor’s position. If a

block of text has been highlighted, the codes will be

inserted before and after this text.

You may also add new codes or frequently used text

to this area for rapid insertion into documents. To

do this, click on the Edit HTML Codes function under

the Options menu.

Editing Area

This is the area in which you will type your text, and

into which document formatting codes will be

inserted.

Status Bar

At the bottom of the window are displayed the cursor

position, the typing mode (Insert o r Overwrite,

which may be switched by pressing the Insert key),

and the file size.

Tool Bar Icons

Use these icons to insert frequently used formatting

codes. You may also choose HTML or custom codes

from the drop-down list beneath the tool bar.

Hyperlink

Jump

Click on this icon to insert a link to another

document or file. Any highlighted text will

be incorporated into the tag as the text

which the user will click.
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Insert

Target

Y o u   ma y i n s e r t   na m ed ta r g e t s ( o r

bookmarks) within your document, to

allow the user to jump to another section.

Go to the place where you wish to insert

the bookmark, then click on the Target

icon. You will be asked to supply a name to

reference this bookmark.

Jump to

Target

I f you have placed targets into your

document  (see above), you may  use this

icon to make a jump to another section of

your document. Simply highlight the text

for the user to click, select this icon, and

choose a target reference name from those

listed.

Insert

Picture

Use this icon to insert an image or video file

into your document. See the following

section for more information about the

various options available with this tool.

Insert

Mail

This icon will insert a tag to allow users to

send mail to a specific address. Place the

e-mail address after “mailto:” in the tag. Any

highlighted text will be incorporated into

the tag as the text users will click. E.g., to

send mail to yourself, the tag would look

something like:

<A href="mailto:YourEmailAddress.net">click here to send e-mail</A>

Insert

Table

Clicking on this icon will display the dialog

for placing a table into the document. The

table will be inserted at the editing cursor’s

position within the text. See the following

section for more information about the

various options available with this tool.
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Insert

List

Use this icon to create various kinds of lists

within your document. The list will be

inserted at the editing cursor’s position.

See the following section for more details.

Line Click on this icon to insert a horizontal line

within the document. A dialog will be

displayed which allows you to select from

among various options (e.g., width, color).

Add

Sound

Use this icon to select an audio file to play

in the background. Check with your

browser’s documentation to determine

which audio file formats are supported.

Add

Scripting

Click on this icon to insert the <Script>

tags needed to contain JavaScript or other

scripted commands. Any highlighted text

will be placed within the Script tags.

Preview U s e t h e s e b u t t o n s t o p r e v i e w y our

document. As different browsers display

documents slightly differently, it is a good

idea to check your work in more than one.

Configure browsers for these buttons using

the Options/Set Web Browsers function.

Copy Places a copy of the selected material onto

the Windows clipboard. It may then be

Pasted into another location, or even into

another program having clipboard support.

Cut Use this icon to remove the selected item

to the Windows clipboard. It may then be

Pasted to another location, or into another

program which supports the clipboard.
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Paste Clicking this icon will insert any material

from the clipboard at the text editing

cursor’s position within the document.

Delete This icon removes the selected material. It

is not placed on the clipboard, and cannot

be Pasted into another location.

Undo Use this icon to reverse the last action

performed.

Redo Clicking on this icon restores the action

deleted by the last Undo.

Character

Format

These icons will insert codes to add

emphasis to the selected text. “B” will make

the text bold; “S” will make the text stand

out, even if it is already bold; “I” will

italicize the text; “E” will emphasize the

text, even if it is already italicized; and “U”

will underscore the text.

Paragraph

Break

Click on this icon to begin a new paragraph.

Any indentation, spacing or other styles set

up for use with paragraphs in the browser

will be displayed.

Line

Break

Use this icon to start a new line within a

paragraph.

Header

Style

Use headers styles for titles, subtitles and

other emphasized text. You have a choice

of degrees of emphasis from <h1> (largest

and boldest) to <h6> (smallest).
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Alignment Select left, center or right alignment for the

current paragraph using these icons.

Font This icon will let you change the font face,

size and color of the selected text.

Color Clicking this icon will drop down a palette

of non-dithering colors. The hexadecimal

code for the selected color will be inserted

at the editing cursor’s position.

Special

Characters

This icon allows you to insert codes for

special characters not present on your key-

board (e.g., accented characters).

Form:

Insert

The contents of forms are usually sent to a

server and processed using a program or

script. The editor allows you to insert form

elements, but consult the documentation

for your form processing program/script to

find how to set up the form. When you click

on this icon, you may specify the Method

used  when  processing  the  form,  and the

Action to take when the user clicks on the

Submit button. Form elements (text, user-

entries, etc.) must be contained between

<form> and </form> tags.

Form:

Checkbox

Use this option inside Form tags. Check

boxes are used when more than one user

choice is allowed. Enter text to display next

to the check box, a Name to identify the

user’s response when processing the form,

and a Value to assign when the user selects

this option. To display the box already

checked, use the Default option.
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Form:

Radio

Button

You may only use this option inside Form

tags. Radio buttons are used when only one

user choice is allowed. Enter a text label to

be displayed next to the button, a Name to

identify a user’s response when processing

the form, and a Value to assign when a user

selects this option. To enable the button

when  the form is first displayed,  place a

checkmark into the Default box.

Form:

Submit

You may only use this option inside Form

tags. The dialog allows you to select from

Normal (clicked/unclicked), Submit (starts

the Action to process the form) and Reset

(clears the form). You may also specify the

text used to label the button, and a Name

to use when processing the form.

Form:

Text

This Form element allows users to type text

to be processed. Select from either Normal

(typed text is displayed) or Password

(typed text is obscured) styles. Select the

Size (width in characters) of the input field,

and a Maximum # of Characters allowed

for the user’s response. Use Text to place

default text into the input box. Finally, use

Name to identify the user’s input when the

form is processed.

Form:

Choices

This dialog allows you to select from either

a multi-line or drop-down style list. Use the

“+” button to add choices to the list (use

the “-” button to remove a choice). Specify

a Name to identify the user’s selection

when the form is processed. The control at

the bottom of the dialog allows you to

determine how much of the list is visible

when displayed to the user.
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Creating Your First Project

These are the steps for creat ing a new HTML

document. See the example at the end of the chapter

for how the finished coded text might look.

Setting Up the Document

Use the New function under the File menu to start a

new document. Complete the fields in the dialog to

provide your document with proper structure.

Header These fields ask for information which

should be placed in the <header> section

of most HTML documents. Use the Title

field to provide a name for the document

(this is the name which appears in the title

bar of many browsers when the document

is displayed). The Author field may be used

to specify who wrote the document, and

may be used to d i sp lay a copyr ight

message. Use the Description f i e ld to
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briefly describe the document’s contents

(this is often the text displayed to users

who locate your document using a search

engine). Use the Style Sheet field to display

the URL for any Cascading Style Sheet (CSS)

file which you would like to use with this

document. The KeyWords field may be used

to list words which might be used to search

for your document (e.g., if the subject is

apples, you might list: tree, fruit, pie,

Delicious, Roma, cider, juice, Beatles,

computer, Macintosh, etc.).

Appearance The items under this tab control the

general appearance of the document. Use

th e Background f i e l d to s pe c i f y the

Filename of an image to use as background

wallpaper (you may click on the folder

button on the right side of the field to

locate a file on your system). The Colors

options allow you to set specific colors for
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elements of the document. Use the Browser

Safe Colors drop-down to select colors

which work with most browser software, or

specify custom colors using the other

controls. The Sound field allows you to

spec i f y an aud io f i l e to p lay in the

background when the page loads. Use the

Loop option to control whether the audio

plays continuously (“0") or plays a specific

number of times before terminating.

Frames Frames a l low you to display severa l

documents in the same browser window.

You should only use the frames options

w h e n y o u i n t e n d to di s p la y o t her

documents, not when creating a normal

text document. Use the arrow selector to

select a frame. Use the horizontal and

vertical buttons to divide a frame into

smaller frames. The “X” button deletes a

currently selected frame.
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You may resize frames by using the selector

arrow to drag the border between frames

to a new location.

Use the Margin options to control how

much space is shown between the frame

border and the text for the selected frame.

Use the Frame Spacing option to specify

the amount of blank space between frames.

Important: Use the Action field to define

the filename for a document to be inserted

into each frame. Frames not assigned

filenames will be blank when viewed in a

browser.

Click OK to write the document’s HTML code.

Entering Text

Scroll down through the document until you find the

<body> and </body> tags. All of the portions of

your document which will be visible to your readers

will be contained between these two tags.

You may simply start typing here. For this example,

just type a few sentences of text.

E.g.,

<body>

This is sentence one. And this is a second sentence.

</body>

Remember to click on the Paragraph icon when you

wish to create a new paragraph, and use the Line

Break icon  to  force  a  new  line  within an  existing

paragraph.

We will add other elements, such as pictures, into

this section in the following steps.
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Linking to Another Document

To place a link to another document residing in the

same directory and drive, highlight the text on which

the user will click to go to the new document, then

click on the Hyperlink icon. Simply type in the name

of the document (e.g., STORY.HTML). If the document

resides in another location, type the URL (Universal

Resource Locator) address and filename (e.g. ,

http://www.cursorarts.com/index.html).

You may also specify Target locations within a

document to which users may jump. To insert a

Target, move the editing cursor to the destination

text and click on the Target icon. Specify a unique

name for the target (e.g., TOP), and the target code

will be inserted. To place a link to the Target,

highlight the text on which the user will click, the

select the Jump to Target icon (left) and select from

the Targets available in the current document.

E.g.,

<body>

<a href=#"TOP"></a>

<p>This is sentence one. And this is a second

sentence.</p>

<p>This is a second paragraph.</p>

<br />

<a href=#"TOP">Click here to go to top.</a>

</body>

Importing a Picture

To place a picture into your document, simply move

your cursor to the location in the text where the

picture will be inserted, then click the Image icon.

Use the Filename field to specify the name of the file

for the desired image. You may also click on the

folder button at the right side of the field to browse

through the files on your system. The image you have
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selected will be displayed in the preview area of the

dialog. Note: some image formats do not display an

image. Instead, a box reflecting the image’s size will

be displayed.

Enable the Use the name only checkbox if the image

file will be located in the same directory as the

document. Do not checkmark the Use the Map Area

box unless you wish to make portions of the image

act as hyperlinks using the options under the Map

Area tab. If your image is very large, you may also

wish to enter descriptive text into the Alternate Text

field. This text will be displayed while the image is

loading into the browser.

Use the Alignment options to place the image in

relation to the text line.

The options under the Map Area and Video tabs may

be explored using the editor’s on-line Help.
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Making a List

To insert a list into your document, move the cursor

to the point at which the list will begin, then click

on the List icon.

Select an Ordered list if you wish the list to use

numerals or letters to designate each item. Select an

Unordered list if you wish each item to be preceded

by a bullet.

Use a Definition style if you wish to list terms,

followed by an explanation of the term (e.g., a

dictionary or catalogue).

Use the List Items box to specify the number of items

within the list.

Then simply type in the text for each item in the list

in the fields in the lower portion of the dialog. You

may click on the Type icons to change the type of

bullet or numeral placed in front of each list item.
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Creating a Table

Tables are often used for things like description lists

or price lists. You may even do things like produce

an entire document within a table, or use a table to

hold sections of a larger image. For starters, how-

ever, it is best to create a simple table.

To insert a table, move your cursor to the location

within the document where the table will begin, then

click on the Table icon  in the toolbar. If desired,

assign your table a Caption, then click on the Stand-

ard tab (see illustration).

Specify the number of Rows down for this table, and

the number of Columns across the page. Once you

have done this, simply select one of the table’s cells,

and enter your text or other information at the

bottom of the dialog.
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You may use the tools in the editing toolbar to

format text, insert images, etc.

Enhanced tables may be created much in the same

way as frames, or as when using the image splitting

options described in the previous chapter. Use the

Horizontal and Vertical icons to split the window

into cells, and type your information into each cell,

add images, etc.

Example Document

The following example shows how a document’s text

would appear if each of the items we’ve discussed

were included.

Note that all of the various document formatting

codes are surrounded by the < and > characters. Use
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the toolbar’s preview buttons to view or print the

document in its final form.

<html>
<head>
<title>Sample Document</title>
<meta name="description" content="This is a short example
of an HTML document.">
<meta name="keywords" content="sample html document
hypertext">
</head>
<body background="RX.JPG">
<a name="TOP"></a>
<p>This is one sentence. This is a second sentence.</p>
<p>This is a second paragraph.</p>
<p><a href="http://www.cursorarts.com/index.html">Click on this
text to go to CursorArts.</a></p>
<p><img sr c= " / 2x2 /R -KEE . JPG" wid th="818" he ight= "524"
alt="sample picture"></p>
<p>
<ul>
<li type="circle">First item in list; </li>
<li type="circle">Second item in list; </li>
<li type="circle">Third item in list. </li>
</UL>
</p>
<p>
<table border="3" cellpadding="3" cellspacing="3" width="100%">
<caption>Sample Table</caption>
<tr><td>Upper left</td><td>Upper center</td><td>Upper
right</td></tr>
<tr><td>Lower left</td><td>Lower Center</td><td>Lower
right</td></tr>
</table>
</p>
<p><a href=#"TOP">Go to Top of Page</a></p>
</body>
</html>

More Information

More information, including a reference for HTML

codes, are available in the Help Topics function

under the Help menu. HTML and other markup

languages are constantly evolving, and you may also

wish to consult books on these subjects or one of the
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many excel lent web sites devoted to creat ing

hypertext and other on-line documents.
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